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Chapter 1. Sterling Gentran:Server CII Overview

About the CII Standard
Japanese Center for Informatization of Industry (CII) provides the Japanese syntax
definition for electronic data interchange messages. The CII Syntax Rule specifies
the details, such as looping structures and data types, of CII messages. The CII
implementation of IBM® Sterling Gentran:Server® for Microsoft Windows is based
on the CII Syntax Rule, which is available in both Japanese and English.

CII does not include standard message types; these are provided by industry
groups (for example, EIAJ for the electronics industry).

See the IBM Sterling Gentran:Server for Microsoft Windows Installation Guide for more
information about installing the Sterling Gentran:Server standards.

CII standard versions

The following are versions of the Japanese Center for Informatization of Industry
(CII) standard that are included in the Sterling Gentran:Server standards database.
Descriptions are available in the standards database, in Japanese.
v CINT0110
v CINT0111
v CINT0112
v EIAJ011A
v EIAJ011B
v EIAJ011C
v EIAJ011D
v EIAJ012E
v EIAJ012F
v EIAJ012G
v EIAJ012H
v EIAJ022D
v EIAJ022T
v FEPCE12A
v FEPCO12A
v FEPCS11A
v FEPCS12B
v FEPCU12A
v HIIS0110
v HWSW001A
v HWSW001B
v JGAS0001
v JISI0105
v JISI0110
v JPCA0101
v JPCA0102
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v JTRNEI00
v JTRNEI2E
v JTRNFF00
v JTRNFF1A
v JTRNFF2A
v JTRNFF2C
v JTRNFF2D
v JTRNJI00
v JTRNTR00
v NEWS0011
v TIRAAS03
v TIRARA01
v TIRARA02
v TIRARA03
v TIRATA01
v TIRATA02
v TIRATA03
v TRPT011A

About Using CII with Sterling Gentran:Server
Sterling Gentran:Server enables you to map to and from CII data documents, along
with other electronic commerce messages in the same manner. This allows you to
maintain a homogenous processing and data management environment, regardless
of how the incoming and outgoing data is formatted (such as CII, XML, EDI, or
proprietary message formats).

You should be familiar with the following.
v Sterling Gentran:Server
v Microsoft Windows
v CII

The following are the software prerequisites to use CII with Sterling
Gentran:Server.
v You must have Sterling Gentran:Server version 5.0 (or later) currently installed.
v You must have installed the CII standards from the Internet or from the CII

Standards Database DVD.

CII Map Objects
Sterling Gentran:Server uses a set of icons to represent CII map objects.

The following table lists the components that make up the CII format, the icons
that represent the components, and descriptions of the components. For
information about adding a map component to a layout and information about the
properties of these map components, see CII File Properties Dialog Box, Group
Properties Dialog Box, and CII TFD Properties Dialog Box.
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Table 1. CII format components

Component Icon Description

CII root element The CII File root element represents the CII document that
Sterling Gentran:Server is mapping.

Group A group contains related groups and transfer form data
(TFDs).

TFD Transfer form data (TFD) is a block of data that consists of a
tag, a length indicator, and data. The length of the element is
always indicated, so delimiters are unnecessary.

When a TFD has a mapping operation performed against it, a
red check mark appears over the TFD icon.

Text and Hex Views
While EDIFACT and ANSI messages can easily be viewed in text mode, it is
usually more appropriate to view CII messages in hex format. Therefore, this
option is available to the user viewing CII data in the Sterling Gentran:Server EDI
Manager (desktop) browsers.

Hex view is the default view for Raw EDI when you view CII messages, but for
the following views, text mode is the default:
v Translator Report
v Tracking Information
v Audit Log

To change the view on a browser, select Text or Hex from the EDI Manager View
menu.
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Chapter 2. Mapping CII Documents

About the CII Data Format
The CII data format provides the Japanese syntax definition for EDI messages. The
CII implementation in Sterling Gentran:Server is based on the CII Syntax Rule,
available in both Japanese and English.

The CII Syntax Rule specifies details such as looping structures and data types, but
it does not include standard message types. Message types are provided by
industry groups. Sterling Gentran:Server provides a number of these standard
message types in the EDI Standards, which you can download.

In Sterling Gentran:Server, a CII map that contains an FA, FD, or F9 data tag in
extended mode on the output side of the map must have a Use Constant standard
rule defined, so that a detail number is generated. A detail number is mandatory
for these tags in extended mode.

For CII inbound and outbound processes, the user has to specify either 8-bit or
16-bit character set in the map. For 8-bit character set, the user can choose JIS0201,
SJIS, or Default, where Default is JIS0201. For 16-bit character set, the user can
choose JIS0208, JIS0212, SJIS, or Default, where Default is SJIS. If a user does not
set these two values, the default value will be used in translation.

CII messages

CII headers and trailers are in text, but messages are binary. To read a raw CII
message outside of Sterling Gentran:Server, you need a hex editor. Using a hex
editor, you can see the basic structure of a CII message, which consists of:
v Control tags
v Transfer form data (TFDs)
v Length indicators
v Data bytes

A typical TFD consists of a tag, a length indicator, and data. The length of the
element is always indicated, so delimiters are unnecessary.

The Sterling Gentran:Server Translation service handles hexadecimal data in the
range of 0x01 through 0xFF. Because the translator does not handle 0x00, it cannot
translate pure binary data such as bitmaps.

In the following sample from a dividing-mode CII message, bold indicates the tag
and italics indicates the length. The data is displayed in hex and spaces are added
here for readability.
... 01 04 34 32 39 30 02 04 30 35 30 34 03 06 39 38 30 35 32 39 ...

Dividing mode

Most CII files are sent in dividing mode (also translated as division mode). This
mode requires the messages to be sent in chunks of 251 bytes to facilitate
communications. To set dividing mode, use the Partner Editor. See CII File
Properties Dialog Box for more information about how to configure dividing mode.
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Dividing mode does not affect message group headers or trailers because they are
always 251 bytes.

Non-transparent mode

According to the CII Syntax Rule, non-transparent mode is an option that helps
you avoid interfering with communication control characters in some
communications systems. Transparent mode is the default setting in Sterling
Gentran:Server.

Extended-mode tags

A TFD is in compressed mode unless an extended-mode indicator (0xF0) was
previously encountered in the TFD stream.

According to the CII specification, tags are in either compressed or extended mode.
The following table illustrates the differences.

Mode Size Range (decimal)

Compressed 1 byte 1 - 239

Extended 2 bytes 1-61439

CII control tags

Table 2. Hexadecimal control tags used in CII

Control Tag Function

0xF0 Starts extended mode

0xF2 Length extender

0xF7 Length indicator

0xF8 Escape indicator

0xF9 Internal segment separator

0xFA/0xFD Multi-detail header (loop start)

0xFB Multi-detail return

0xFC Multi-detail trailer (loop end)

0xFE Message Trailer

Map Types
The following are the available map types.

Map Type Description

Import Used for outbound maps.

Export Used for inbound maps.

Interchange break Used in advanced mapping to separate interchanges.

Functional
Acknowledgement
Inbound

Used in advanced mapping to reconcile functional
acknowledgements.
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Map Type Description

Functional
Acknowledgement
Outbound

Used in advanced mapping to generate functional
acknowledgements.

System Import Header Used to determine which trading relationship (established in
Partner Editor) corresponds to each document in the application
file, so the system knows which import translation object to use
to process the document.

Turnaround Used for EDI to EDI maps.

Transaction build Used in advanced mapping to build transaction envelopes.

Transaction break Used in advanced mapping to separate documents.

Functional group build Used in advanced mapping to build functional group
envelopes.

Functional group break Used in advanced mapping to separate functional groups.

Interchange build Used in advanced mapping to build interchange envelopes.

Creating a Map
You can create four different types of maps: System Import (containing the header
information for an Import map), Import (for Outbound Maps), Export (for Inbound
Maps), or Turnaround (for EDI to EDI maps). The initial procedures for creating a
new map of each of the four types is the same.

About this task

Use this procedure to create a map.

Procedure
1. Select File > New.

The system displays the New Map Wizard.
2. Enter the following information and click Next:

v Select the type of map
v Type the unique name of the map. The system adds the .MAP extension.
v Type your name if it differs from the user name prompted by the system.
The system displays the New Map Wizard - Input Format dialog box.

Note: You need to complete the format for the Input side of the map (Steps 3
- 7). This is the format of the data that is translated by the Sterling
Gentran:Server system.

3. For the input side of the map, do one of the following:
v Create a data format using a syntax that you define - go to step 4.
v Load the data format from a saved definition - go to step 7.

4. Select one of the following input format options:
v Delimited EDI (Electronic Data Interchange file)
v Positional (VDA, GENCOD, application files)
v CII (Japanese standard)
v CII Positional (for CII Build/Break maps)

Notes:
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v For Inbound maps (Export), the Input Format Type is CII or EDI.
v For Outbound maps (System Import or Import), the Input Format Type is

Positional.
v For Turnaround maps, the Input Format Type is EDI or CII.

5. If you selected Delimited EDI or CII and want to customize the format, click
Customize and continue with the next step. Otherwise, click Next and
continue with step 9.
The system displays the New Delimited EDI Wizard or New CII Wizard
dialog box. The Delimited EDI and CII wizards enable you to create your
format from the standards database.

6. Follow the steps for the appropriate dialog box:
v If the dialog is New Delimited EDI Wizard, do the following:

a. Click Next.
b. Select the ODBC data source that contains the standards database.
c. Select the standards agency, version, transaction set, and (for

TRADACOMS) release number and click Next.
d. Click Finish.

v If the dialog is New CII Wizard, do the following:
a. Click Next.
b. Select the ODBC data source that contains the standards database.
c. Specify if you want to use Japanese descriptions and click Next.
d. Select the standards agency, version, transaction set, and (for

TRADACOMS) release number and click Next.
e. Select the appropriate Multi-detail header and click Next.
f. Click Finish.

The system displays the New Map Wizard - Output Format dialog box.
Continue with step 8.

7. To load the data format from a saved definition, select Load the data format
from a saved definition and either enter the path and filename of the saved
definition or browse to navigate and select the file.

Note: You can select either a .DDF or .IFD file. If the DDF is invalid, the
system displays a message box explaining the problem and terminates the
import.

8. For the output side of the map, do one of the following:
v Load the data format from a saved definition - go to step 12.
v Create a data format using a syntax that you define - go to step 9.

9. Select one of the following input format options:
v Delimited EDI (Electronic Data Interchange file)
v Positional (VDA, GENCOD, application files)
v CII (Japanese standard)
v CII Positional (for CII Build/Break maps)

Notes:

v For Inbound maps (Export), the Output Format Type is CII or EDI.
v For Outbound maps (System Import or Import), the Output Format Type is

Positional.
v For Turnaround maps, the Output Format Type is EDI or CII.
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10. If you selected Delimited EDI or CII and want to customize the format, click
Customize and continue with the next step. Otherwise, go to step 13.
The system displays the New Delimited EDI Wizard or New CII Wizard
dialog box. The Delimited EDI and CII wizards enable you to create your
format from the standards database.

11. Follow the steps for the appropriate dialog box:
v If the dialog is New Delimited EDI Wizard, do the following:

a. Click Next.
b. Select the ODBC data source that contains the standards database.
c. Select the standards agency, version, transaction set, and (for

TRADACOMS) release number. Click Next.
d. Click Finish.

v If the dialog is New CII Wizard, do the following:
a. Click Next.
b. Select the ODBC data source that contains the standards database.
c. Specify if you want to use Japanese descriptions and click Next.
d. Select the standards agency, version, transaction set, and (for

TRADACOMS) release number. Click Next.
e. Select the appropriate Multi-detail header and click Next.
f. Click Finish.

The system displays the New Map Wizard dialog box. Continue with step 13.
12. To load the data format from a saved definition, select the Load the data

format from a saved definition option and either enter the path and filename
of the saved definition or browse to navigate and select the file.

Note: You can select either a .DDF or .IFD file. If the DDF is invalid, the
system displays a message box explaining the problem and terminates the
import.

13. Click Finish to load the standards information you selected and create the
new map (this may take a few seconds).
The system displays the new map in the Application Integration Window.

What to do next

After you finish creating and saving a new map, you need to define the Input and
Output sides of the map. The steps you take are different, depending on whether
the map is an Import, System Import, Export, or Turnaround map.

CII File Properties Dialog Box
CII File Properties dialog box contains several tabs: Name, Mode, Character Sets,
and Loop Extended Rules.

Table 3. Name tab parts and functions

Part Function

Name Map component name.
Note: Do not use spaces or hyphens (-) in the name. You can
use the underscore (_) to separate words.

Description Description of the map component.
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Table 3. Name tab parts and functions (continued)

Part Function

Additional notes When you import an XML schema, the annotation attached
to each XML map component is saved in this box. For
non-XML map components, contains any user-defined
comments.

Table 4. Mode tab parts and functions

Part Function

Dividing Mode Most CII files are sent in dividing mode (also translated as
division mode). This mode requires the messages to be sent
in chunks of 251 bytes to facilitate communications. To set
dividing mode, use the Partner Editor.

Non-Transparent Mode According to the CII Syntax Rule, non-transparent mode is
an option that helps you avoid interfering with
communication control characters in some communications
systems. Transparent mode is the default setting in Sterling
Gentran:Server.

Table 5. Character Sets tab parts and functions

Part Function

Select 8 Bit Character Set Valid values are Default, JIS-X0201, and Other. Default
instructs the translator to use the default character setting of
the computer on which the translator is running. Use Other
if you must specify any other type of character encoding.

Select 16 Bit Character Set Valid values are Default, JIS-X0208, and Other. Default
instructs the translator to use the default character setting of
the computer on which the translator is running. Use Other
if you must specify any other type of character encoding.

Table 6. Loop Extended Rules tab parts and functions

Part Function

On Begin Extended rule to be run before the translator processes the
map object.

On End Extended rule to be run after the translator concludes
processing the map object. Application Integration processes
On End rules at the end of each loop occurrence, not at the
end of all loops.

Full Screen Maximizes the dialog box.

Compile Compiles the extended rule. This function enables you to
view compile errors for this rule prior to compiling the
translation object. This function gives you immediate
feedback about the accuracy of your rule. Double-click an
error to immediately navigate to the line containing the error.

The rule is also compiled when you compile the map.

Extended rule Defines the extended rule.

Errors Displays any errors generated when you clicked the Compile
button to compile the extended rule. Double-click an error to
make the cursor go to the line containing the error.
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Group Properties Dialog Box
The Group Properties dialog box contains several tabs: Name, Looping, and
Looping Extended Rules.

Table 7. Name tab parts and functions

Part Function

Name Map component name.
Note: Do not use spaces or hyphens (-) in the name. You can
use the underscore (_) to separate words.

Description Description of the map component.

Additional notes When you import an XML schema, the annotation attached
to each XML map component is saved in this box. For
non-XML map components, contains any user-defined
comments.

Table 8. Looping tab parts and functions

Part Function

Minimum usage Minimum number of times the loop must be repeated.

For a conditional loop, the minimum usage is zero.

Maximum usage Maximum number of times the loop must be repeated.

Promote records to parent Select this check box to specify that when the group is
compiled, the subordinate records and groups are extracted
from the loop and located in the parent group. This function
is valid for single iteration subgroups only.
Note: Select this check box if you are mapping the fields in
this group to data that is not grouped in the output.

Table 9. Looping Extended Rules tab parts and functions

Part Function

On Begin Extended rule to be run before the translator processes the
map object.

On End Extended rule to be run after the translator concludes
processing the map object. Application Integration processes
On End rules at the end of each loop occurrence, not at the
end of all loops.

Full Screen Maximizes the dialog box.

Compile Compiles the extended rule. This function enables you to
view compile errors for this rule prior to compiling the
translation object. This function gives you immediate
feedback about the accuracy of your rule. Double-click an
error to immediately navigate to the line containing the error.

The rule is also compiled when you compile the map.

Extended rule Defines the extended rule.

Errors Displays any errors generated when you clicked the Compile
button to compile the extended rule. Double-click an error to
make the cursor go to the line containing the error.
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CII TFD Properties Dialog Box
The CII TFD Properties dialog box contains several tabs: Name, Tag, Looping,
Validation, Standard Rule, Extended Rule, and Character Set.

Table 10. Name tab parts and functions

Part Function

Name Map component name.
Note: Do not use spaces or hyphens (-) in the name. You can
use the underscore (_) to separate words.

Description Description of the map component.

Additional notes When you import an XML schema, the annotation attached
to each XML map component is saved in this box. For
non-XML map components, contains any user-defined
comments.

Table 11. Tag tab parts and functions

Part Function

Tag The element ID, which is defined by a CII standard.

Hex

Decimal

Whether you view the tag in hexadecimal or decimal and
applies only to what you see in Application Integration. This
setting does not affect translation.

Table 12. Looping tab parts and functions

Part Function

Normal

Loop Start

Loop End

Loop Repeat

Type of loop. Values are:

v Normal – In the loop, but is not the beginning or ending

v Loop Start – Marks the beginning of the loop

v Loop End – Marks the end of the loop

v Loop Repeat – Marks the end of one loop iteration and the
beginning of the next iteration

Table 13. Validation tab parts and functions

Part Function

Mandatory field Select this check box to indicate that the map component is
required.

Minimum length Minimum number of characters in the map component.

Maximum length Maximum number of characters of the map component.
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Table 13. Validation tab parts and functions (continued)

Part Function

Data-type Type of data for this map component. Valid values are:

v String - Alphanumeric

v Number - Numeric, real, overpunched, or packed (for
Positional only)

v Date/time - Date or time

v Bin Data - binary data (only available if you select
“Binary” on the Special tab of the EDI Segment Properties
dialog box)

v Bin Length - length of binary data (only available if you
select “Binary” on the Special tab of the EDI Segment
Properties dialog box)

Note: If you select Binary, you must define an element of
data-type Bin Length and another element of data-type Bin
Data. The Bin Length element must precede the Bin Data
element.

Data format How the data in the map component will be formatted.
Depending on the data type you selected, you can either:

v For the String data-type, select a syntax token to denote
that this map component must be formatted as the syntax
token dictates.

v Free Format indicates that any characters are acceptable in
the field. The translator does not check the characters for
compliance.

v For Number or Date/Time data-type, select the data
format from a list.

Data is Read/written as
Raw Bytes

Type of byte ordering:

v Little-endian byte ordering specifies that the least
significant character is first. Intel and Windows use this
order.

v Big-endian byte ordering specifies that the most significant
character is first. UNIX and Java™ use this order.

Table 14. Standard Rule tab parts and functions

Part Function

Please select the standard
rule to use

v Select

v Update

v Use System Variable

v Use Constant

v Use Accumulator

v Loop Count

v Use Code

Table 15. Extended Rule tab parts and functions

Part Function

Extended Rule Area where you type the extended rule.

Full Screen Enlarges the extended rule area to the size of your entire
display to give you more room to see what you type.
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Table 15. Extended Rule tab parts and functions (continued)

Part Function

Compile Compiles the extended rule. This function enables you to
view compile errors for this rule prior to compiling the
translation object. This function gives you immediate
feedback about the accuracy of your rule. Double-click an
error to immediately navigate to the line containing the error.

The rule is also compiled when you compile the map.

Errors If you compiled this extended rule, any warnings or errors
are displayed in the Errors list. Double-click an error to make
the cursor go to the line containing the error.

Table 16. Character Set tab parts and functions

Part Function

Character Set Select 8 Bit if the TFD is single-byte and 16 Bit if the TFD is
double-byte.

About Loops
In CII terminology, a loop is expressed as a multi-detail. Multi-details are indicated
through the use of specific TFDs.

Before the start of a loop is a multi-detail header (MDH). At the end of each
iteration is the multi-detail return (MDR). The multi-detail trailer (MDT) is at the
end of the loop.

Table 17. Configuration for multi-details

TFD Type Tag Properties

Multi-detail header (MDH) 0xFA One-byte string

MDH 0xFD Two-byte binary numeric type N0

Multi-detail return (MDR) 0xFB No data

Multi-detail trailer (MDT) 0xFC No data

Table 18. Tag properties

Tag Data Type Range of Values

0xFA String A to Z, 1 to 9

0xFD String 0000 to 65535

Configuring Key Fields for Multi-Detail Headers
In extended mode, multi-detail headers must be identified with key fields. You
must also specify key fields if there is any possibility of ambiguity in the data (for
example, if a multi-detail in the CII file layout has no corresponding data).

About this task

To configure a key field for a multi-detail header, complete the following steps.
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Procedure
1. In Application Integration, double-click or right-click the multi-detail header

and select Properties.
2. Click the Key Field tab.
3. Select Use constant and click Edit.
4. In the Map Constants dialog box, type the constant you need.

About Character Encoding
An encoding system determines the hexadecimal values that represent display
characters. Application Integration uses the default character set of the computer
you are working on.

The default encoding for Japanese Windows is Shift-JIS although there are several
other encoding systems for Japanese characters.

The Sterling Gentran:Server CII implementation supports the following character
conversions:
v Shift-JIS to JIS x0201 (no conversion required)
v Shift-JIS to JIS x0208
v JIS x0201 to Shift-JIS (no conversion required)
v JIS x0208 to Shift-JIS

When you are specifying character sets for the CII side of a map, you must
indicate one character set each for 8-bit and 16-bit characters in the CII File
Properties dialog box. Then in the CII TFD Properties dialog box, you indicate
whether the TFD uses an 8-bit or 16-bit character set.

Setting up Character Set Conversion
An encoding system determines the hexadecimal values that represent display
characters. Application Integration uses the default character set of the computer
you are working on.

About this task

To set up character set conversion, complete the following steps.

Procedure
1. In the CII File Properties dialog box, select the Character Sets tab.
2. From the lists, select an 8-bit character set and a 16-bit character set. The

choices for 8-bit are Default and JIS-X0201. The choices for 16-bit are Default,
JIS-X0208, and Other.

3. Double-click the first string-type TFD and select the Character Set tab.

Note: You must open the dialog box to select 8-bit or 16-bit. This selection
refers to the choices made in the CII File Properties dialog. The default will be
8-bit. If a user changes a 16-bit TFD to numeric, and changes again to string,
the default will be 8-bit.

4. Select either the 8 bit (Default) or 16 bit option.

Notes:
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v This selection refers to the choice you made in step 2 on the CII File
Properties dialog box.

v If you change a 16-bit TFD to numeric and change it again to string, the
default will be 8-bit.

v The settings in Partner Editor override the settings in the map. See About
Setting up CII Partners for more information.

CII Data Attributes and Application Integration Data Types
The following table shows how CII data attributes correspond to the data types in
Application Integration:

Description of Data CII Attribute
Application Integration
Data Type

Numeric, implied decimal 9 N0 to N9

Numeric, explicit decimal N R0 to R9

8-bit characters X X, J, or other single-byte
syntax token

16-bit characters K K, double-byte syntax token

8-digit date Y Date: YYYYMMDD

Syntax Tokens

To process Japanese characters, you must use a syntax token that enables non-Latin
characters in the data that the map will process. Application Integration provides
the syntax token K, which enables all double-byte Japanese characters.

You can create a syntax token to meet your specific needs. For more information
about syntax tokens and creating them, see the IBM Sterling Gentran:Server for
Microsoft Windows Application Integration User Guide. If you create a double-byte
character set (DBCS) syntax token, you must configure the syntax tokens on a
computer with a DBCS operating system (Japanese, Korean, Traditional Chinese, or
Simplified Chinese) or a Windows 2000 system to which you have added font
support for one of those languages. If you do not, the DBCS button is inactive; you
cannot use it. Syntax tokens cannot be imported.

Some syntax tokens are provided in Application Integration. If you need a different
syntax token, you can create a syntax token to meet your needs.

Note: When you create a syntax token, it applies only to the current map. You
must create a syntax token for each map you create.

Creating a Syntax Token for Asian Languages
Double-byte character set (DBCS) syntax tokens enable you to create a map that
accepts double-byte characters.

About this task

The DBCS button is active on the Syntax Tokens dialog box if:
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v You are running Application Integration on a Chinese, Japanese, or Korean
version of the supported Windows operating systems (see the IBM Sterling
Gentran:Server for Microsoft Windows Quick Start Guide for information on which
operating systems are supported).

v You have added font support for one of these languages to a Windows 2000
system.

DBCS tokens are displayed only in the DBCS Syntax Tokens dialog box, not in the
list on the Syntax Tokens dialog box.

To create a DBCS token, complete the following steps.

Procedure
1. From the Application Integration Edit menu, select Syntax Tokens.
2. Click DBCS. The system displays the DBCS Syntax Tokens dialog box.
3. From the Codepage list, select the 932 codepage to map Japanese characters.
4. Click New.
5. In the Edit DBCS Syntax Token dialog box, in the Token field, type the unique

one-character alphanumeric value that Application Integration recognizes as
containing the allowed range of characters you designate.

6. Select the lead byte from the Lead-Byte box.

Note: Double-byte characters are composed of a lead byte and a trail byte. For

example, the character is code point 93F9 (lead byte 93, trail byte F9).
7. To exclude individual characters or groups of characters from the token (you

do this if there are certain characters that you will not accept in your data),
make characters unavailable by either:
v Clicking a character to make it appear shaded.
v Dragging the cursor across a group of characters to make them appear

shaded
8. Click Close to save the syntax token.

Deleting a Syntax Token
About this task

To delete a syntax token, complete the following steps.

Procedure
1. From the Application Integration Edit menu, select Syntax Tokens.
2. If you are deleting a DBCS syntax token, click DBCS.
3. Select the token you want and click Delete.

The selected syntax token is deleted without a warning message.

Deleting a Character Range
About this task

To delete a character range from a syntax token, complete the following steps.
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Procedure
1. From the Application Integration Edit menu, select Syntax Tokens.
2. If you are deleting a character range for a DBCS syntax token, click DBCS.
3. Select a syntax token and click Change.
4. Select the character range you want and click Delete.

The selected syntax token is deleted without a warning message.

Preserving Leading Spaces When Mapping to a Positional Data Format
In the EDIFACT and ANSI standards, leading spaces in fields are eliminated.
However, in the CII format, according to the CII Syntax Rule, leading spaces are
typically preserved (although they can be eliminated).

About this task

To preserve leading spaces in a map for translating CII to the positional format,
complete the following steps.

Procedure
1. From the Application Integration Edit menu, select Details.
2. In the Map Details dialog box, select Use Configurable Trimming and click

OK.
3. In each field on the positional side of the map, open the Field Properties dialog

box and click the Position tab.
4. If the spaces are single-byte, do the following:

a. In the "characters used in empty portions of the map" box, type SP.
b. From the data alignment options, select beginning of the field.

5. If the spaces in the field are double-byte and the data is encoded in Shift-JIS
(windows codepage 932), for "Enter the character used in empty portions of the
field", type 0x8140 or the appropriate key code combination.

6. Click OK.

Changing to Non-Transparent Mode
According to the CII Syntax Rule, non-transparent mode is an option that helps
you avoid interfering with communication control characters in some
communications systems. Transparent mode is the default setting in Sterling
Gentran:Server.

About this task

To change to non-transparent mode, complete the following steps.

Procedure
1. Open a map in Application Integration.
2. Right-click the top icon on the CII side of the map, and select Properties.
3. Click the Mode tab, and select Non-Transparent Mode.

Note: Note that the settings in Partner Editor override the settings in the above
dialogs. See About Setting up CII Partners for more information.
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Finalizing your CII Map
All maps, regardless of format, follow the same steps.

See the IBM Sterling Gentran:Server for Microsoft Windows Application Integration User
Guide for information on how to finalize your CII map.
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Chapter 3. Setting up Sterling Gentran:Server for CII

Registering your CII Maps
The Register Translation Object function enables you to register your CII
translation object file with Sterling Gentran:Server so the system can identify the
translation object.

About this task

To register a translation object, complete the following steps.

Procedure
1. In the EDI Manager, select View > Translation Objects.

The system displays the EDI Translation Object browser.
2. Click New.

The system displays the Register Translation Object dialog box.
3. Select or enter the CII translation object file that you want to register with the

system.

Note: You can use the Shift and Ctrl keys to select multiple objects.
4. Click Open.

The system registers the translation object files exits the Register Translation
Object dialog box.

Notes:

v If the selected file is invalid, you receive a warning message. Only valid
Sterling Gentran:Server translation object files can be installed.

v If the translation object is a duplicate, you are prompted with a message
asking whether or not you want to overwrite the existing translation object.

Defining an Import Specification
You need to define an import specification for each type of file (such as file
location, file name, and file extension) that you are importing. If you want to
import files from a location, from a specific file name, or from files with a specific
extension that is not currently defined in an import specification, you need to
create a new import specification.

About this task

To define a new import specification, complete the following steps.

Procedure
1. From the Start menu, select Programs > Gentran Server> Gentran Server

Configuration.
The system displays the System Configuration dialog box (Controllers tab).

2. Select the Imports tab.
3. Click New.
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The system allows you to define a new import specification.
4. In the File Path box, enter the file type or browse to select the folder. We

recommend that you enter a file type in this box, rather than specifying a path
and folder. This ensures that users can import files of the specified type from
their local drives without using UNC file names.

Note: For a Mailbox Import, you must specify the UNC path and file name.
This must exactly match the path you set for the TRANSIN directory on the
Directories tab.
The system displays the Choose Directory dialog box.

5. Select the directory and click OK.
6. From the Translation Object list, select the CII import or system import

translation object that you want the system to use to begin translation when a
file of the specified type is imported.

Note: Some Japanese import files use a six-character field for the version
number while others use an eight-character field.

7. Either click OK to exit the System Configuration program or click Apply to
save the import specification without exiting System Configuration.

About Setting up CII Partners
Setting up a CII partner is similar to setting up other partners, with the following
exceptions:
v There are several values that can be configured on the Generic Interchange

Envelope dialog box.
v The structure of CII messages dictates that you must select <none> for Groups

for both Inbound and Outbound relationships.

See the IBM Sterling Gentran:Server for Microsoft Windows User Guide for
comprehensive information on how to create partner relationships.

The Generic Interchange Envelope dialog box

To access the Generic Interchange Envelope dialog box, from the EDI Manager,
select Partners > Outbound > Interchanges >Edit > Envelope.

The following table describes the non-generic fields on this dialog box, and the CII
column indicates how they are used for CII partners.

Dialog Box Component How it is used in CII Valid Values

Decimal notation Not used. Not used.

Segment code separator Non-transparent mode S or space = transparent

M = non-transparent

Release indicator Not used. Not used.

Component element
separator

16-bit character set S or space = JISX0208

D = Shift-JIS

Element separator 8-bit character set S or space = JISX0201

M = Shift-JIS
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Dialog Box Component How it is used in CII Valid Values

Segment terminator Dividing mode S = non-dividing

M or space = dividing

Note: These settings override anything you configured in the map.

Using the CII Total-Items-Number Feature
According to the CII Syntax Rule, there are two areas in the message group header
reserved for total-items number, a checksum function. Each area consists of two
fields, which hold the TFDs to be totalled; they are mutually exclusive. One area is
for compressed-mode TFDs. The other is for extended-mode TFDs. In Sterling
Gentran:Server, you identify these fields in Partner Editor.

About this task

To configure the CII total-items-number feature, complete the following steps.

Procedure
1. In the Outbound Relationship dialog box, click Interchanges.
2. Select the appropriate interchange and click Edit.

The system displays the Outbound Interchange Entry dialog box.
3. Click Envelope.

The system displays the Generic Interchange Envelope dialog box.
4. Type the tags (in decimal) of the two TFDs that you want to sum.

v If your map uses compressed-mode tags, type the tags in Field 21 and Field
22.

v If the map uses extended-mode tags, type the tags Field 23 and Field 24.

Example

Compressed mode example

To sum TFDs 00003 and 00011, type the following on the Generic Interchange
Envelope dialog box:

Field Value you type

Field 21 003

Field 22 011

Notes:

v The TFDs must be numeric or string type.
v The TFDs must contain only single-byte numeric characters, not alphabetic

characters.
v Sterling Gentran:Server sums all TFDs with the identified TFD tag.
v In the output file, the totals are placed in 15-byte fields in the message group

trailer, as specified in the CII Syntax Rule.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.S.A.

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law

IBM Japan Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku

Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
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incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation

J46A/G4

555 Bailey Avenue

San Jose, CA 95141-1003

U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.
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This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© IBM 2012. Portions of this code are derived from IBM Corp. Sample Programs. ©
Copyright IBM Corp. 2012.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at http://www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

IT Infrastructure Library is a registered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government
Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.
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Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

ITIL is a registered trademark, and a registered community trademark of the Office
of Government Commerce, and is registered in the U.S. Patent and Trademark
Office.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the
United States, other countries, or both and is used under license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are
trademarks of HP, IBM Corp. and Quantum in the U.S. and other countries.

Connect Control Center®, Connect:Direct®, Connect:Enterprise®, Gentran®,
Gentran®:Basic®, Gentran:Control®, Gentran:Director®, Gentran:Plus®,
Gentran:Realtime®, Gentran:Server®, Gentran:Viewpoint®, Sterling Commerce™,
Sterling Information Broker®, and Sterling Integrator® are trademarks or registered
trademarks of Sterling Commerce®, Inc., an IBM Company.

Other company, product, and service names may be trademarks or service marks
of others.
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